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Poznamka pre pouzZivatel'ov systému Mac

Niektoré klavesové skratky a polozky ponuky su v systéme Mac iné ako v systémoch Windows
a Linux. V nasledujucej tabulke sa nachadzaju najdélezitejSie rozdiely, ktoré sa vztahuju na
informacie v tejto prirucke. PodrobnejSi zoznam sa nachadza v Pomocnikovi aplikacie.

Windows alebo Ekvivalent pre Mac Ug&inok

Linux

Nastroje > LibreOffice > Nastavenia Otvori nastavenia s moznostami

MozZnosti

Pravé kliknutie Ctrl+kliknutie a/alebo pravé Otvori sa kontextova ponuka
kliknutie v zavislosti na systéme
pocitaca

Ctrl (Control) ¥ (Command) Pouziva sa s inymi klavesmi

F5 Shift+38+F5 Otvori sa Navigator

F11 #+T Otvori sa okno Styly a formatovanie
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Co je Draw?

LibreOffice Draw je kresliaci program na zaklade vektorovej grafiky, hoci méze byt pouzity tiez na
vykonévanie urcitych operacii na rastrovej grafike (bodové). Pomocou programu Draw mdZzeme
rychlo vytvorit Siroku Skalu obrazkov.

Vo vektorovej grafike su obrazky ukladané a zobrazované pomocou jednoduchych geometrickych
prvkov ako Usecky, kruznice a mnohouholniky a nie ako sady bodov na obrazovke. Vektorova
grafika umoznuje lahSie obrazok ukladat a menit' jeho velkost.

Program Draw je plne integrovany do balika LibreOffice, €o zjednoduSuje vymenu obrazkov
s ostatnymi stuCastami balika. Ak napriklad vytvorime obrazok v programe Draw, v programe
Writer ho pouZijeme tak, Zze ho jednoducho skopirujeme do schranky a vloZzime. S kresbami
mébzeme pracovat aj priamo z programu Writer alebo Impress, a to pomocou sady funkcii a
néstrojov z Draw.

MozZnosti programu Draw su znacné, a hoci nebol navrhnuty ako nahrada pokroc€ilych grafickych
programov, obsahuje viac funkcii, nez maju nastroje pre kresby, ktoré su v kancelarskych balikoch
spravidla integrované.

Niekolko prikladov funkcii pre kresby: sprava vrstiev, mriezka s prichytavanim, zobrazenie kot a
mierky, spojnice pre vytvaranie organizacnych grafov, funkcie na vytvaranie trojrozmernych kresieb
(s texturou a svetelnymi efektmi), integracia kresby a Stylu stranky a Bézierove krivky.

V tejto kapitole su uvedené niektoré vlastnosti programu Draw, nejde o vy€erpavajlci opis
vSetkych vlastnosti. Viac informacii sa nachadza v priru¢ke Navod na pouZivanie programu Draw
(Draw Guide) a v pomocnikovi k programu.

Hlavné okno programu Draw

Hlavné sucasti hlavného okna programu Draw, zobrazené na obrazku 1, su:
¢ Hlavna ponuka
* Panel nastrojov Standardné
* Panel nastrojov Ciara a vypli
* Panel Strany
* Pracovny priestor
e Stavovy riadok
* Panel nastrojov Kresba
* Postranny panel

Pracovny priestor

Rozsiahla oblast v strede okna (pracovnd plocha) slizi na vytvaranie kresieb. Okolo tejto oblasti
mozno umiestnit panely s nastrojmi a oblasti s informéciami. Poet a umiestnenie viditelnych
nastrojov zavisi na vykonavanej ¢innosti a na pouzivatel'skom nastaveni, preto pracovny priestor
mdZe vyzerat aj inak, ako na obrazku 1.

Maximalna velkost kresby je v programe LibreOffice Draw 300 cm krat 300 cm.

Hlavné okno programu Draw 7



Panel nastrojov

Hlavnd ponuka Standardny panel nistrojov jara a vypli

Bez_ndrvu 1 - Libredffice Draw
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Obréazok 1: Pracovna plocha programu LibreOffice Draw
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Panel Strany

Kresbu v programe Draw mdZeme rozdelit' na niekolko stran. Viacstrankové kresby sa pouZzivaju
najma na prezentacie. Panel Strany poskytuje prehlad stran, ktoré kresba obsahuje. Ak panel
Strany nie je zobrazeny, zvolime Zobrazit’ v hlavnej ponuke a zvolime Panel Strany. Ak chceme
zmenit poradie stran, staci jednu alebo viac stran presunut.

Postranny panel

Postranny panel ma Styri hlavné Casti — podpanely. PoZzadovany podpanel zobrazime kliknutim na
jeho ikonu alebo kliknutim na znacku s trojuholnikom nad ikonami a zvolenim z kontextovej
ponuky. Zobrazeny méZe byt len jeden podpanel. Ak nie je postranny panel zobrazeny, v hlavnej
ponuke zvolime Zobrazit' > Postranny panel.

i
Vlastnosti:
Otvori podpanel s polami, v ktorych méZeme menit vlastnosti objektov. Tieto polia su VioZit
utvary, Znak, Odsek, Oblast, Ciara a Umiestnenie a velkost.

Hlavné okno programu Draw 8
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Styly a formatovanie h
V tejto asti mdézeme upravit’ Styly a pouzit' ich na objekty kresby. Ak Styl upravime, zmeny sa
automaticky prejavia na vSetkych objektoch, formatovanych tymto Stylom.

L
Galéria
Otvori galériu, odkial mézeme do kresby vkladat' objekty, a to bud ako képiu, alebo ako odkaz.
Kopia objektu je nezavisla od originalu, a preto zmeny originalu képiu neovplyvnia. Odkaz je
zavisly od originalu, a preto zmeny originalu sa prejavia aj v odkaze.

M
Navigeitor'“‘ﬂf"|
Otvori Navigator, pomocou ktorého sa mézeme rychlo presuvat medzi strAnkami kresby alebo
v kresbe vyberat objekty. Aby bolo mozZné stranky a objekty kresby v navigatore lfahko
rozpoznat, je vhodné im davat zmysluplné nazvy.

Pravitka

Pravitka (listy s Cislami) sa zobrazuju na hornej a lavej strane pracovnej plochy. Ak nie su
zobrazené, mo6zeme ich povolit volbou Zobrazit’ > Pravitko v hlavnej ponuke. Velkost vybratého
objektu je na pravitkach zobrazena pomocou dvoijitej Ciary (zvyraznena na obrazku 2). Pokial nie
je ziadny objekt vybrany, je na nich zobrazené umiestnenie kurzora, o pomaha pri presnom
umiestriovani objektov.

Pravitka m6zeme pouzit' aj na lahSie umiestiovanie pomocou Uchytiek objektov a pomocnych Ciar.

Na pravitkach su tiez znazornené okraje strany. Tieto okraje mdZzeme priamo zmenit tym, Ze ich na
pravitkach presunieme mySou. Oblast okrajov je na pravitkach vyznacena sivou farbou, ako
ukazuje obrazok 2 (vlavo hore).

Pre kazdé pravitko méZeme nezavisle zmenit' merna jednotku tym, Ze klikneme pravym tlacidlom
mysSi na pravitko a zvolime poZadovanu jednotku, ako je to zndzornené pre vodorovné pravitko na

obrazku 3.
rm'¢'$4'$|'é®

Obrazok 2: Pravitka zobrazujuce velkost vybratého objektu

Hlavné okno programu Draw 9
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Obréazok 3: Jednotky pravitka

Stavovy riadok

Stavovy riadok sa nachadza v dolnej Casti obrazovky vo vSetkych sucastiach balika LibreOffice,
pricom v programe Draw obsahuje niekolko Specifickych poli. Podrobnosti o obsahu a pouziti
tychto poli sa nachadzaju v tejto priruCke v kapitole 1, Predstavujeme LibreOffice , av kapitole 1,
Predstavujeme program Draw v prirucke Navod na pouZivanie programu Draw (Draw Guide) .

Informacna Velkost Elektronicky Posuvac
oblast objektu podpis zvatsenia

v WA RN

|'I.|'ybrar1é: Tvar | 173 3,59 /5,31 :%! 66,15x 43,61 [*  |Snimka 1/ 1 (Rozlozenie) | Predvolend | — — 00— 4| 100%‘

pozicia NeuloZené Cislo Percentudlne
kurzora Zmeny snimky zvatienie

Obrazok 4: Stavovy riadok v programe Draw

Velkosti su uvedené v aktualnych mernych jednotkach a mézu sa liSit od jednotiek
pravitok. Mernu jednotku stavového riadku uréime v Nastroje > MoZnosti >
LibreOffice Draw > VSeobecné, kde mdzeme tieZ zmenit mierku stranky.

Panely nastrojov

Ak chceme v programe Draw zobrazit alebo skryt panely nastrojov, zvolime Zobrazit' > Panely
nastrojov v hlavnej ponuke. V ponuke, ktord sa zobrazi, zvolime panel, ktory chceme zobrazit'.
Viac informacii o praci s panelmi nastrojov sa nachadza v tejto prirucke v kapitole 1, Uvod do
programu LibreOffice.

V nasledujucej Casti st opisané nastroje dostupné na paneloch nastrojov programu Draw. Vzhlad
ikon na paneloch néastrojov m6ze zavisiet na operatnom systéme a na velkosti a Style ikon
zvolenych v Nastroje > MozZnosti > LibreOffice > Zobrazenie.

Hlavné okno programu Draw 10



Panel nastrojov Standardné
Panel nastrojov Standardné je rovnaky pre vSetky sGcasti balika LibreOffice a nie je v tejto

kapitole podrobnejSie opisany.
Standardny =
B-E-UER [ EE Y KR B B@I@Q- @

Obréazok 5: Panel nastrojov Standardné

Panel nastrojov Kresba

Panel Kresba je najdélezitejSim panelom v programe Draw. Obsahuje vSetky funkcie potrebné na
kreslenie ré6znych Utvarov, €i uz geometrickych alebo od ruky, a funkcie potrebné na ich
usporiadanie na stranke.

Kresba v
il /2 EH@TH|€-L%-=2-@8-@-¢-F-PF -%- <5 adE

Obrazok 6: Panel nastrojov Kresba

Panel nastrojov Ciara a vyplri

Panel nastrojov Ciara a vypli umoZfiuje zmenit hlavné vlastnosti kresby. Ikony a roletové
zoznamy sa mozZu menit v zavislosti od typu vybratého objektu. Ak chceme napriklad zmenit Sty
Ciary, klikneme na symbol Sipky nahor a nadol v poli Styl Ciary a zvolime poZzadovany Styl.

Giara a vyplii v
B f = - v | |0,00mm % | N Tango ¥ | @ Farba v v H| & - - -

Obrézok 7: Panel nastrojov Ciara a vyplri

Panel nastrojov Formatovanie textu

Ak je vybrany text, panel Ciara a vyplii sa zmeni na panel Formatovanie textu, ktory sa podoba
panelu nastrojov Formatovanie v programe Writer. Viac informacii sa nachadza v tejto prirucke
Vv kapitole 4, Zaciname s programom Writer.

Formatovanie textu v X
£ 6 I8 EA Al A -

liberationSans v | (18 ~| B J U A

Obrazok 8: Panel nastrojov Formatovanie textu

Panel nastrojov MozZnosti

Panel nastrojov MoZnosti slUzi na zapinanie a vypinanie r6znych pomocok na kreslenie. Tento
panel nie je v predvolenom nastaveni zobrazeny. Zobrazime ho tak, Ze zvolime Zobrazit' > Panely
nastrojov > MozZnosti.

Moznosti ¥ X

Obrézok 9: Panel nastrojov MoZnosti
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Farby

Lo I )L ]I (N . -

Obréazok 10: Dialégové okno Farby

Vol'ba a definovanie farieb

Ak chceme zobrazit' dialogové okno Farby (obrazok 10), zvolime Zobrazit' > Panely nastrojov >
Panel farieb, ¢im zobrazime aktuélnu paletu farieb. Toto dialdgové okno umoznuje rychlo zvolit

farbu réznych objektov (Ciar, oblasti a 3D efektov). Prvé pole listy predstavuje neviditelnu (Ziadnu)
farbu.

V programe Draw je mozné pouzivat niekolko Specializovanych farebnych paliet a tieZ v nich aj
menit jednotlivé farby podla vlastnych potrieb. To moZno vykonat v dialbgovom okne Oblast, ktoré

sa zobrazi, ked v hlavnej ponuke zvolime Format > Oblast’ alebo klikneme na ikonu Oblast @
na nastrojovej liste Ciara a vyplf a potom zvolime zaloZzku Farby (obrazok 11).
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Obréazok 11: Dialégové okno Oblast — karta Farby

Ak chceme nacitat’ inu paletu, klikneme na ikonu Nacitat’ zoznam farieb g V dialégu na vyber
suboru zvolime niektoru paletu pre balik LibreOffice (subory s priponou * . soc). Napriklad

web . soc je farebna paleta upravena pre vytvaranie kresieb pre webové stranky. Farby tejto palety
sa zobrazia spravne na vsetkych zariadeniach, ktorych obrazovka je schopna zobrazit aspon 256
farieb.

V poli na vyber farby mézeme tiez zmenit jednotlivé farby tym, Ze zmenime ¢iselné hodnoty

v poliach nachadzajlcich sa napravo od farebnej palety. MéZeme pouZzit farebné schémy
oznacované ako CMYK (Cyan, Magenta, Yellow, Black — azdrova, purpurova, ZIta, Cierna) alebo
RGB (Red, Green, Blue — Cervena, zelena, modrd).

Ak klikneme na tlacidlo Upravit’, otvori sa dialégové okno Farby, v ktorom mozeme jednotlivé farby
nastavit. DalSie informéacie sa nachadzaju v Casti ,MoZnosti farieb” v kapitole 2, Nastavenie balika
LibreOffice.

PodrobnejSi opis farebnych paliet a ich moZnosti je uvedeny v kapitole 10, Pokrocilé techniky na
kreslenie, prirucky Navod na pouZivanie programu Draw (Draw Guide).

Volba a definovanie farieb 13



Kreslenie zakladnych utvarov

Program Draw ponika vyber zo Sirokej Skaly Gtvarov, ktoré si umiestnené v paletach dostupnych
Z panelu nastrojov Kresba (obrazok 6), Uplny zoznam tychto nastrojov je zobrazeny na obrazku 12.
Ikony a tlaCidla, ktoré sa na paneli nastrojov Kresba nachadzaju v predvolenom nastaveni, su
zvyraznené sivym pozadim (obrazok 12).

Wywojove diagramy

[% Wybrat® Q Bubliny
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Obréazok 12: Nastroje dostupné na paneli nastrojov Kresba

V tejto Casti je opisanych iba niekolko zakladnych utvarov vratane textu, s ktorymi program Draw
pracuje ako s objektmi. Uplny opis dostupnych Utvarov sa nachadza v prirucke Draw Guide.

Niektoré ikony na paneli nastrojov Kresba sa budu menit’ podla toho, aky Utvar zvolime
z dostupnych volieb. Dostupné palety nastrojov zobrazime kliknutim na trojuholnik v pravej Casti
ikony.

Ked nakreslime zakladny utvar alebo ho vyberieme kvéli Gpravam, na lavej strane
Poznamka stavového riadkLl sa zmeni pole Informacie tak, aby zodpovedalo vykonavanej
akcii: napriklad Ciara vytvorena, Textovy ramec xxyy vybrany a podobne.

Kreslenie priamych Ciar

Klikneme na ikonu Ciara / a kurzor umiestnime do bodu, v ktorom ma Ciara zaCinat’ (obrazok
13). Tahame my3ou, pricom drzime tlacidlo mysi stlacené. Uvolnime tlagidlo mysi v bode, v ktorom
ma Ciara koncit. Na oboch koncoch Ciary sa zobrazia uchytky, ktoré znamenaju, Ze dany objekt je
momentalne vybrany. Uchytka v poCiato¢nom bode je o nieco vacsia nez ostatné Gchytky
oznacujuce vyber.

Ak pri kresleni Ciary podrzime stlaceny klaves Shift, Ciara bude méct byt nakreslena iba pod
uhlom, ktory je nasobkom 45 stupriov (0, 45, 90, 135, atd).

Kreslenie zakladnych atvarov 14



Ide o predvolené spravanie klavesu Shift. Ak vSak je vybrand moZznost' Pri
vytvarani alebo presuvani objektov v Casti Pozicia zachytavania v Nastroje >

Poznamka MozZnosti > LibreOffice Draw > MrieZka, funkcia klavesu Shift bude opacna.
Ciary budd automaticky vytvarané pod uhlami v nasobkoch 45 stupiiov, ak nebude
stlaceny klaves Shift.

Ak pri kresleni podrzime stlaceny klaves Ctrl, koniec Ciary sa prichyti na najblizSi bod mriezky.

Vychodiskovy bod

Obrazok 13: Kreslenie priamej Ciary

Ide o predvolené spravanie klavesu Ctrl. Ak je vSak zaSkrtnuta moznosti Zachytit’
Poznamka na mriezku v ponuke Zobrazit' > Mriezka, klaves Ctr/ prichytavanie k mriezke
vypne.

Ak pri kresleni Ciary podrzime klaves Alt, Ciara sa bude vytvarat symetricky podla pociato¢ného
bodu, a teda bude od neho smerovat na obe strany. To umozinuje nakreslit' Ciaru tak, ze zacneme
od jej stredu.

Ked je Ciara nakreslena, ma vlastnosti nastavené na predvolené hodnoty. Ak chceme akukolvek
vlastnost’ zmenit, vyberieme Ciaru tym, Ze na fu klikneme, potom na fu klikneme pravym tlacidlom
mysi a v kontextovej ponuke zvolime Ciara alebo v hlavnej ponuke zvolime Format > Ciara, ¢im

otvorime dialdgové okno Ciara (obrazok 14). Pripadne mozeme kliknat na ikonu Vlastnosti ' na
postrannom paneli a otvorit' pole Ciara. Styl, Sirku a farbu Ciary mozno tiez zmenit pomocou
ovladacich prvkov na paneli nastrojov Ciara a vyplii v hornej €asti pracovnej plochy.

Kreslenie zakladnych Gtvarov 15
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Obréazok 14: Dialégové okno Ciara

Kreslenie Sipok

Sipky sa kreslia podobne ako &iary. V skuto€nosti st v programe Draw Sipky povaZzované za druh
Ciar: Ciary so Sipkami. V poli v stavovom riadku su vo vypise informacii oznacované len ako Ciary.

Ak chceme nakreslit ipku, klikneme na ikonu Ciara konéiaca Sipkou — na paneli nastrojov
Kresba alebo v poli VioZit Gtvary v podpaneli Vlastnosti na postrannom paneli. Sipka sa nakresli
v koncovom bode Ciary, akonahle uvolnime lavé tlacidlo mysi.

Zakoncenie Ciary

V programe Draw je dostupnych niekolko typov zakonceni Ciary (Sipky, kruhy, Stvorce a dalSie). Po

kliknuti na trojuholnik napravo od ikony Ciary a $ipky ~ na paneli nastrojov Kresba alebo

v paneli VioZit utvary v podpaneli Vlastnosti na postrannom paneli sa otvori paleta, ktor4 obsahuje
nastroje na kreslenie Ciar a Sipok. Alternativne méZeme volbou Zobrazit’ > Panely nastrojov >
Sipky otvorit plavajuci panel Sipky (obrazok 15). Na paneli nastrojov Kresba alebo v poli VioZit
atvary vo Vlastnostiach na postrannom paneli sa zobrazuje ikona naposledy pouzitého nastroja, ¢o
ulahCuje jeho opatovné pouZzitie.

~ . {_
Styl Sipok nakreslenej Ciary mézeme zmenit tak, Ze klikneme na ikonu Styl Sipky —< na paneli
nastrojov Ciara a vypln a zvolime pociato€nu a koncovu Sipku.

Kreslenie zakladnych atvarov 16
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Obréazok 15: Panel nastrojov Sipky a dostupné nastroje

Kreslenie obdiZznikov alebo $tvorcov

Kreslenie obdiZnikov sa podobé kresleniu priamych &iar. Klikneme na ikonu ObdiZnik [ na
paneli nastrojov Kresba alebo v poli VioZit Gtvary vo Vlastnostiach na postrannom paneli. Ked
obdlZnik kreslime pomocou kurzora mysi, zobrazuje sa jeho vrchol na mieste kurzora.

Stvorce su obdizniky, ktoré maju vsetky strany rovnako dlihé. Ak chceme nakreslit Stvorec,

klikneme na ikonu ObdiZnik l;l, a pri kresleni Stvorca podrzime klaves Shift.

Ak je zaSkrtnuta moznost Pri vytvarani alebo prestvani objektov v Nastroje >
MozZnosti > LibreOffice Draw > VSeobecné, je funkcia Shift opacna. Ked je

Poznamka zvoleny nastroj Obdiznik, nakresli sa Stvorec. Ak chceme nakreslit obdiZnik, pri
kresleni treba stlacit klaves Shift. Opacna funkcia klavesu Shift sa uplatfiuje tieZ pri
kresleni elips a kruznic.

Ak chceme nakreslit obdiznik alebo Stvorec z jeho stredu namiesto z vrcholu, umiestnime kurzor
na miesto stredu, stlacime tlaidlo mySi a potom pri prestvani kurzora podrZzime klaves Alt.
Pociatoény bod (kam sme prvykrat klikli favym tlagidlom mysi) potom bude stredom obdiZnika
alebo Stvorca.

Kreslenie kruhov a elips

Ak chceme nakreslit' elipsu (tiez oznacovanu ako oval), klikneme na ikonu Elipsa @ na paneli
nastrojov Kresba alebo v poli VIoZit' utvary vo Vlastnostiach na postrannom paneli. Kruh je elipsa
s rovnako dihymi osami. Ak chceme nakreslit kruh, klikneme na ikonu Elipsa a pri kresleni kruhu
podrzime klaves Shift.

Ak chceme nakreslit’ elipsu alebo kruh z ich stredu, umiestnime kurzor na miesto stredu, stlacime
tlacidlo mySi a potom pri tahani ukazovatelom podrzime klaves Alt. PocCiato¢ny bod (kam sme
prvykrat klikli tlacidlom mysi) potom bude stredom elipsy alebo kruhu.

Kreslenie zakladnych atvarov 17



Ak najprv stlacime a podrzime klavesu Ctr/ a potom klikneme na niektorG z ikon

Ciara, Obdiznik, Elipsa alebo Text, v pracovnej oblasti sa automaticky nakresli
Poznamka objekt Standardnej velkosti; jeho velkost, tvar a farba budu tiez Standardné.

V pripade potreby mdzeme tieto vlastnosti neskér zmenit. Viac informacii sa

nachadza v prirucke Draw Guide.

Kreslenie kriviek a mnohouholnikov

Ak chceme nakreslit krivku alebo mnohouholnik, klikneme na ikonu Krivka ‘t‘i na paneli
nastrojov Kresba alebo v poli VIoZit utvary vo Vlastnostiach na postrannom paneli. Po kliknuti na
trojuholnik napravo od ikony sa otvori paleta, ktory obsahuje nastroje na kreslenie kriviek a
mnohouholnikov (obrazok 16). Na paneli nastrojov Kresba sa zobrazuje ikona naposledy
pouZzitého nastroja, ¢o ulahcuje jeho opatovné pouZitie.

Ak presunieme kurzor mysi nad niektora ikonu, zobrazi sa bublinovy tip s popisom funkcie.

- %
W ERZLOEL &

<

Krivka, vyplnena
Mnohouholnik, vyplneny
Mnohouholnik (45%), vyplneny

Ciara volnou rukou, vyplnena
Krivka

Mnohouholnik
Mnohaouhaolnilk: (45%)

PR RExE ©§

Ciara volnou rukou

Obréazok 16: Panel néstrojov Krivky (Ciary) a dostupné ndstroje

Ak kurzor mysi presunieme nad tuto ikonu, zobrazi sa pomocny tip Krivka. Ak vSak
otvorime plavajuci panel nastrojov, jeho nazov je Ciary, ako ukazuje obrazok 16.

Ak pri kresleni nastrojom Krivka alebo Mnohouholnik podrzime klaves Shift, uhly
medzi Ciarami budld obmedzené na 45 alebo 90 stupriov.

Poznamka

Krivky

Ak chceme vytvorit' poCiato€ny bod krivky, stlacime lavé tlacidlo mysSi, a zatial o ho drzime
stlatené, tahame mySou z pociato&ného bodu, &im kreslime &iaru. Ciaru deformujeme na krivku
tym, Ze uvolnime lavé tlaCidlo mySi a pokracujeme v tahani kurzoru mysi. Kliknutim nastavime
koncovy bod krivky, a tym aj pevné umiestnenie Ciary na stranke. Ak chceme pokraCovat,
presuvanim kurzoru mySi nakreslime priamu Ciaru. Kazdym dalSim kliknutim vloZime vrchol a
mdzeme potom z tohto vrcholu pokra€ovat kreslenim dalSej priamej Ciary. Kreslenie Ciary
ukoncime dvojkliknutim.

V pripade vyplnenej krivky sa automaticky spoji posledny bod s prvym, objekt sa tak uzavrie a
vyplni aktualnou farbou vyplne. Krivka bez vyplne na konci kreslenia uzavreta nebude.

Kreslenie zakladnych Gtvarov



Mnohouholniky

Klikneme a nakreslime z poc€iato€ného bodu prvu Ciaru, pricom drzime lavé tlacidlo mysi stlacené.
Akonahle tlacidlo mySi uvolnime, zacne sa kreslit' iara medzi prvym a druhym bodom. Presunom
kurzora nakreslime dalSiu Ciaru. Kazdym kliknutim mySou vloZime vrchol a méZeme pokracovat
kreslenim dalSej Ciary. Kreslenie ukon€ime dvojkliknutim.

V pripade vyplneného mnohouholnika sa automaticky spoji posledny bod s prvym, objekt sa tak
uzavrie a vyplni aktualnou farbou vyplne. Mnohouholnik bez vyplne na konci kreslenia uzatvoreny
nebude.

Mnohouholniky 45 °

Su rovnako ako obyc¢ajné mnohouholniky vytvarané z €iar, uhly medzi ¢iarami su vSak obmedzené
na 45 alebo 90 stupnov.

Ciary vol'nou rukou

Nastroj na kreslenie Ciar volnou rukou sa pouZziva podobne, ako sa kresli ceruzkou na papieri.
Stla¢ime a podrzime lavé tlacidlo mySi a tahame kurzorom tak, aby sme vytvorili poZadovany tvar
Ciary. Kresbu nie je nutné ukonCovat dvojkliknutim, staci uvolnit tlaCidlo mySi a kresba je hotova.

Ak je vybrana Ciara volnou rukou, vyplnena, koncovy bod sa automaticky spoji s pociatoénym a
objekt sa vyplIni prislusnou farbou.

Pridavanie textu

Ak chceme aktivovat nastroj pre text, klikneme v pripade vodorovného textu na ikonu Text T a

v pripade zvislého pisma na ikonu Zvisly text '_] Pokial nie je ikona Zvisly text zobrazena,
skontrolujeme, &i je zaSkrtnuta moznost Azijské jazyky v Nastroje > MoZnosti > Nastavenia
jazyka > Jazyky. Ak je vybrand ikona Text, zobrazi sa panel nastrojov Formatovanie textu
(obrazok 8 na strane 11); z ktorého moZzeme predtym, neZ zacneme pisat, vybrat druh pisma, jeho
velkost' a dalSie vlastnosti textu.

Poznamka | ona zvisly text = je k dispozicii iba na paneli nastrojov Kresba.

Po aktivovani prikazu Text klikneme tam, kam chceme text umiestnit. Objavi sa maly textovy
ramec, ktory obsahuje len kurzor. Tento ramec je mozné presuvat ako kazdy iny objekt. Textovy
ramec je tiez dynamicky, zvacSuje sa podla toho, ako zadavame text.

V informacnom poli v stavovom riadku sa zobrazuje sprava, Ze upravujeme text, spolu
s podrobnostami o aktualnom umiestneni kurzora, a to pomocou Cisla odseku, riadka a stlpca
(obrazok 17).
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- Zadavanie textu v ramceku
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Obrazok 17: Informéacie o texte v stavovom riadku

Zalomenie riadku méZeme vloZit kombinéciou klavesov Shift+Enter, novy odsek zaCheme
pomocou klavesu Enter. VloZenie zalomenia riadku alebo nového odseku neukonci Upravu textu
ani nezrusi vyber textového ramca. Ked sme s pisanim textu hotovi, klikneme na miesto mimo
textového ramca, ¢im vkladanie a Upravu textu ukoncime.

Ak chceme text upravit, dvojklikneme na neho, €¢im sa otvori panel nastrojov Forméatovanie textu a
upravovany text sa vyberie.

Vlastnosti textu mozno tiez zmenit po€as jeho zadavania, zmeny sa pritom pouZiji od umiestnenia
kurzora dalej. Ak chceme zmenit vlastnosti vSetkého textu v textovom ramci, vSetok text v ramci
treba vybrat.

Je mozné vytvorit Styly obrazka, ktoré mézeme opakovane pouzit' aj na iné textové ramce.
Zvolime Format > Styly a formatovanie alebo stlagime F11, &m otvorime dialégové okno Styly a
forméatovanie. MdZeme tieZ kliknat na ikonu Styly a formatovanie E na postrannom paneli. Styly
obrazka ovplyviuju vSetok text vnutri textového rdmca. Ak chceme formatovat' iba Casti textu,
pouZzijeme nastroje na priame formatovanie, ktoré st dostupné na paneli Forméatovanie textu alebo
v poliach Znak a Odsek vo podpaneli Vlastnosti na postrannom paneli.

Textoveé ramce mozu byt vyplnené aj farbou, m6ézu mat tiene a dalSie vlastnosti, rovhako ako
akykolvek iny objekt v programe Draw. R@mec mdzeme otodit' a napisat’ text pod akymkolvek
uhlom. Tieto moznosti st dostupné po kliknuti pravym tla¢idlom mySi na textovy ramec.

Ak dvojklikneme na graficky objekt, stlaCime F2 alebo klikneme na ikonu Text vo chvili, kedy je
objekt vybrany, mézeme do grafického objektu pridat’ text. Tento text sa stane sucastou grafického
objektu.

Graficky objekt v3ak nie dynamicky a nesprava sa ako textovy ramec. Ak chceme text udrzat’
v medziach objektu, musime pouZit odseky, zalomenie riadku alebo mensSiu velkost textu, zvacsit
velkost objektu alebo skombinovat vSetky Styri sposoby.

Viac informacii sa nachadza v kapitole 2, Kreslenie zakladnych dtvarov a kapitole 9, Pridavanie a
formatovanie textu v prirucke Navod na pouZivanie programu Draw (Draw Guide).
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Zachytné body a spojnice

Zachytné body
VSetky objekty v programe Draw maju zachytné body, ktoré sa za norméalnych okolnosti

nezobrazuju. Zachytné body sa zobrazia, ak je aktivovana ikona Spojnice 010 na paneli nastrojov
Kresba alebo v poli VioZit dtvary vo Vlastnostiach na postrannom paneli. Vacsina objektov ma Styri
zachytné body (obrazok 18). Je vS8ak mozné pridat viac zachytnych bodov a prispdsobit ich, a to
pomocou panelu nastrojov Zachytné body (obrazok 19). Tento panel nastrojov otvorime pomocou
Zobrazit' > Panely nastrojov > Zachytné body.

Zachytné body nie su to isté ako Uchytky na vyber objektu. Uchytky sliZia na presun a zmenu
tvaru objektu. Zachytné body sa pouzivaju pre zachytenie spojnice k objektu, takZze spojnica potom
zostane k objektu prichytena aj po jeho premiestneni. PodrobnejSi opis pouZzitia zachytnych bodov
sa nachadza v kapitole 3, Praca s objektmi a bodmi objektov a v kapitole 8, Spojnice a vyvojové a
organizacné diagramy prirucky Navod na pouZivanie programu Draw (Draw Guide).

Obréazok 18: Zachytné body
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Obrazok 19: Zachytné body a dostupné nastroje

Spojnice

Spojnice su Ciary alebo Sipky, ktorych konce sa automaticky prichytavaju k zachytnym bodom
objektu. Su uzito€né najma pri kresleni organizanych diagramov, vyvojovych diagramov a
myslienkovych map. Ak st objekty presunuté alebo inak usporiadané, spojnice zostavaju pripojené
k zachytnym bodom. Obrazok 20 zobrazuje ukazku dvoch objektov a spojnice.

Program Draw ponuka vela ré6znych spojnic. Ak na paneli nastrojov Kresba alebo v poli VioZit
utvary vo Vlastnostiach na postrannom paneli klikneme na trojuholni¢ek vedla ikony Spojnica

.10 ", otvori sa panel nastrojov Spojnice (obrazok 21). Podrobnejsi popis pouZitia spojnic sa
nachédza v kapitole 8, Spojnice a vyvojové a organizacné diagramy prirucky Navod na pouZivanie
programu Draw (Draw Guide).

Obrazok 20: Spojnica medzi dvoma objektmi
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Spajnica zadnajlca Sipkou Priama spojnica

Spojnica kondiaca Sipkou Priama spojnica zadnajica Sipkou

Spojnica so Sipkami Priama spojnica kondaca- Sipkou

Spojnica zadinajica krazkom Priama spojnica so Sipkami

Spojnica kondiaca krtizkom Priama spojnica zadinajaca krizkom

Spojnica s kruznicami Priama spojnica kondaca krdzkom

Spojnica Priama spojnica s kruznicami

Priama spojnica Zakrivena spaojnica

Priama spojnica zadinajlca Sipkou Zakrivena spojnica zadinajlca Sipkou

Priama spojnica kondiaca Sipkou Zakrivena spajnica kondaca Sipkou

Priama spojnica so Sipkami Zakrivena spojnica so Sipkami

Priama spojnica zadinajica krizkom Zakrivena spajnica zafinajdca krikom

Priama spojnica kondaca krizkom Zakrivend spojnica konfiaca krizkom
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Priama spojnica s krizkami Zakrivend spaojnica g krugnicami

Obrazok 21: Panel nastrojov Spojnice a dostupné nastroje

Kreslenie geometrickych utvarov

Ikony na kreslenie geometrickych Gtvarov si umiestnené na paneli nastrojov Kresba, pricom kazdy
geometricky Utvar je vysvetleny v nasledujucich oddieloch. Kliknutim na trojuholnik napravo od
ikony na paneli nastrojov Kresba alebo v poli VioZit' Gtvary vo Vlastnostiach na postrannom paneli
otvorime plavajuci panel nastrojov, pomocou ktorého mézeme pristupovat k nastrojom pre dany
geometricky utvar.

Nastroje pre geometrické Utvary sa pouZivaju podobne ako nastroje na kreslenie
obdlZnikov a Stvorcov. Viac informacii sa nachadza v Casti ,Kreslenie zakladnych

Tip Utvarov” na strane 14 a v kapitole 2, Kreslenie zakladnych dtvarov prirucky Navod
na pouZivanie programu Draw (Draw Guide).
” Ikony geometrickych Utvarov zobrazené na paneli nastrojov Kresba sa menia
Poznamka y 49 Ky P ;

podla toho, aky nastroj bol naposledy vybrany a pouzity na nakreslenie objektu.

Zakladné utvary

Klikneme na trojuholnik napravo od ikony Zakladné utvary Q ¢im otvorime panel nastrojov
Zakladné Gtvary umoznujuci kreslenie tychto uUtvarov. Na tomto paneli sa nachadza aj nastroj na
kreslenie obdiZnikov totoZny s tym, ktory uZ je zobrazeny na paneli Kresba alebo v poli VioZit
utvary vo Vlastnostiach na postrannom paneli.
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Obrazok 22: Panel nastrojov Zakladné atvary

Utvary symbolov

Klikneme na trojuholnik napravo od ikony Utvary symbolov @ ¢im otvorime panel nastrojov
Utvary symbolov umoZniujici kreslenie symbolov.

Utvary symbaolov w
@) Ve )
O @@

Obrézok 23: Panel néstrojov Utvary symbolov

Blokové Sipky

Klikneme na trojuholnik napravo od ikony Blokové Sipky %, &im otvorime panel néstrojov

Blokové Sipky umoziujuci kreslenie tychto Sipok.

Blokové Sipky
G L i kP Lo
S PDPBPAgaPREBROGAYSs

Obréazok 24: Panel nastrojov Blokové Sipky

Vyvojové diagramy

Klikneme na trojuholnik napravo od ikony Vyvojové diagramy EI;I ¢im otvorime panel nastrojov
Vyvojovy diagram so symbolmi pouzivanymi pri kresleni vyvojovych diagramov. Vytvaranie
vyvojovych diagramov, organizacnych diagramov a podobnych nastrojov na planovanie je dalej
opisané v kapitole 8, Spojnice a vyvojové a organizacné diagramy priru¢ky Navod na pouZivanie
programu Draw (Draw Guide).

Vyvojovy diagram v X
eI/ NEHNTFse AV

CRAEAFR@SXcALATVEPCGEDS@®

Obrazok 25: Panel nastrojov Vyvojové diagramy

Bubliny

Klikneme na trojuholnik napravo od ikony Bubliny Q , Cim otvorime panel nastrojov Bubliny
umoznujuci kreslenie bublin.
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Obréazok 26: Panel nastrojov Bubliny

Hviezdy a panely

Klikneme na trojuholnik napravo od ikony Hviezdy Tﬂ}'& ¢im otvorime panel nastrojov Hviezdy a
panely, umoznujuci kreslenie hviezd a dalSich ozdobnych utvarov.

Hviezdy a panely v
MY RERBRSRELEQ@

Obréazok 27: Panel nastrojov Hviezdy a panely

Ku vSetkym tymto geometrickym Gtvarom moZeme pridat text. Viac informacii sa
Poznamka nachadza kapitolach 2, Kreslenie zakladnych ttvarov, a 10, Pokrocilé techniky na
kreslenie, prirucky Navod na pouzivanie programu Draw (Draw Guide).

Vyber objektov

Priamy vyber

Najjednoduchsi spdsob, ako vybrat’ objekt, je priamo na neho kliknat. Objekty, ktoré nie st
vyplnené, vyberieme tak, Ze klikneme na ich obrys. Prvym kliknutim objekt vyberieme, druhym
kliknutim vyber zruSime. Ak chceme vybrat' alebo zruSit' vyber viacerych objektov, podrzime pri
kliknuti klaves Shift.

Vyber pomocou oramovania

Niekolko objektov naraz m6zeme tiez vybrat tak, Ze objekty oramujeme pomocou kurzoru mysi. Pri
tahani kurzorom sa okolo objektov kresli obdlznik, pricom vybrané su len tie objekty, ktoré lezia
celé vnatri tohto obdlZnika.

Ak chceme vybrat’ pomocou oramovania viacero objektov, musi byt zapnuta ikona Vybrat’ k na
paneli nastrojov Kresba.

Vyber skrytych objektov

Objekty je mozné vybrat aj vtedy, ked' s umiestnené za inymi, a nie su preto viditelné. Podrzime
klaves Alt a klikneme na objekt v popredi, ktory zakryva skryty objekt, potom klikneme znova, ¢im
skryty objekt vyberieme. Ak je skrytych objektov niekolko, pokraCujeme so stlatenym klavesom Alt
v klikani, kym nevyberieme objekt, ktory hfadame. Ak chceme prechadzat’ objekty v obratenom
poradi, pri klikani stlac¢ime kombinaciu klavesov Alt+Shift.

Ak na vybrany objekt klikneme, zobrazi sa jeho obrys cez objekty, ktoré ho zakryvaju.

Pouzitie klavesu Alt funguje na pocitaCoch s operacnymi systémami Windows
Poznamka alebo Mac. Na pocitacoch s operacnym systémom Linux je nutné pouZzit dalej
opisany spbsob vyuZivajuci Tab.
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Ak chceme vybrat objekt, ktory je zakryty inym objektom, pomocou klavesnice, pouzijeme klaves
Tab. Pomocou neho cez objekty postupne prechddzame, pricom zastavime na poZzadovanom
objekte. Ak chceme objekty prechadzat v opacnom poradi, stlaCame Shift+Tab. Tento spdsob
vyberu objektu je velmi rychly, sthva sa ale nepraktickym v pripade, ked kresba pozostava

z velkého poctu objektov.

Usporiadanie objektov

V zlozitejSich kresbach moze byt viac objektov umiestnenych na sebe. Ak chceme zmenit ich
usporiadanie tak, aby nejaky objekt bol blizSie alebo dalej, objekt vyberieme, v hlavnej ponuke
zvolime Objekt > Usporiadat’ > Preniest’ bliZzSie alebo Preniest’ d'alej. Alternativne klikneme
pravym tlacidlom mySi na objekt a z kontextovej ponuky zvolime Usporiadat’ > Preniest’ blizSie
alebo Preniest’ dalej.

Moznosti na usporiadanie su tiez dostupné po kliknuti na trojuholnik napravo od ikony Usporiadat’

na paneli nastrojov Ciara a vyplii. Tym otvorime panel nastrojov Poloha, pomocou ktorého
mobzeme nastavit rdzne moznosti usporiadania (obrazok 28).

Poloha v
OO0 R D e |
ﬂ Preniest’ dopredu
L]| Preniest blif¥ie
% Preniest’ d'alej
59 Preniest dozadu

@ Pred objekt
% Za objekt
&8 obratt

Obrazok 28: Panel nastrojov Poloha a dostupné nastroje

Presun a nastavenie vel'kosti objektov

Ked presuvame objekt alebo menime jeho velkost, je vhodné si vSimnat lfava stranu stavového
riadka (obrazok 29). Zlava doprava sa tu zobrazuje, aky objekt je vybrany, jeho umiestnenie na
kresbe v suradniciach X a Y a jeho rozmery. Merné jednotky zodpovedaju jednotkdm vybranym
v Nastroje > Moznosti > LibreOffice Draw > VSeobecné.

Viac informacii o prestvani a nastavovani velkosti objektov sa hachadza v kapitole 3, Praca
S objektmi a bodmi objektov prirucky Navod na pouzivanie programu Draw (Draw Guide).
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Obrazok 29: Lava strana stavového riadku pocCas presunu alebo zmeny
velkosti objektu

Presuvanie objektov

Ak chceme presunut objekt (alebo skupinu objektov), vyberieme ho, potom klikneme dovnutra
objektu a drziac stlacené lavé tlaCidlo mysi mySou tahdme. Pocas pohybu sa zobrazuje priehladny
obrazok kopie objektu, ktory ulah€uje umiestnenie objektu (obrazok 30). Ak chceme objekt
umiestnit na nové miesto, uvolnime tlacidlo mysi.

Obrazok 30: Presun objektu

Nastavenie velkosti objektu

Ak chceme zmenit velkost vybratého objektu (alebo skupiny vybranych objektov), presunieme

kurzor mySi na niektort z Uchytiek vyberu. Kurzor mysi sa zmeni tak, Ze ozna€uje smer pohybu
prislusny pre danud uchytku vyberu. Ked menime velkost objektu, zobrazuje sa menej vyrazny

obrys objektu (obrazok 31). Az nastavime pozadovanu velkost, uvolnime tlacidlo mysi.

Vysledok zavisi na tom, ktord uchytku vyberu pouzijeme. Ak chceme zmenit' velkost objektu len
v smere jednej osi, pouZijeme postranné uchytky. Ak chceme zmenit velkost v smere oboch osi,
pouzijeme rohové uchytky.
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Obrazok 31: Nastavenie velkosti objektu

Ak pri zmene velkosti objektu stlatime klavesu Shift, zmena velkosti bude rovnaka
v oboch osiach, t. j. zachova sa pomer stran objektu. Toto spravanie klavesu Shift
funguje so vSetkymi Uchytkami vyberu.

Ide o predvolené spravanie klavesu Shift. Ak je vSak zaSkrtnuta volba Pri vytvarani
alebo presune objektov v Nastroje > Moznosti > LibreOffice Draw > Mriezka, je
funkcia klavesu Shift opacna — pomer stran bude zachovany, ked klaves Shift
nestlacime.

OtoCenie a skosenie objektu

Viac informacii o oto€eni a skoseni objektu sa nachadza kapitole 3, Praca s objektmi a bodmi
objektov priru€ky Navod na pouzivanie programu Draw (Draw Guide).

OtocCenie objektu
Ak chceme otocit objekt (alebo skupinu objektov), vyberieme ho, a potom prejdeme pomocou
niektorého z nasledujlcich spésobov do rezimu otacania:

* Klikneme na ikonu Otocit @ na paneli nastrojov Ciara a vypli.

e Zvolime Zobrazit' > Panely nastrojov > ReZim a zvolime ikonu Otocit @

Uchyty vyberu zmenia tvar a farbu (obrazok 32). V strede objektu sa tieZ zobrazi stred otacania. Ak
kurzor mySi presunieme nad Uchytku, kurzor zmeni tvar. Rohové Uchytky slGZia na otoCenie
objektu a horné, dolné a postranné Uchytky na skosenie objektu.
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Obrazok 32: OtocCenie objektu

Presunieme kurzor mySi na niektort rohova Uchytku, pricom sa kurzor zmeni na oblik so Sipkou
na oboch koncoch. Stlac¢ime tlaCidlo mySi, a zatneme presuvat kurzor, ¢im objekt otdame.
Zobrazi sa priehladny obrazok ota¢aného objektu a v stavovom riadku sa zobrazi aktualny uhol
otoCenia.

Pre 3D objekty funguje ota€ania odliSne kvdli tomu, Ze objekt sa otaca okolo
Poznamka globalnej osi a nie okolo jednotlivych osi. Viac informécii sa nachadza v kapitole 7,
Praca s 3D objektmi prirucky Navod na pouzivanie programu Draw (Draw Guide).

Stred otaCania sa beZne nachadza v strede objektu. Ak chceme zmenit umiestnenie stredu
otaCania, uchytime ho mySou a presunieme ho na pozadované miesto. Stred ota€ania méze byt
umiestneny dokonca aj mimo objekt.

Ak pri otdCani objektu stlacime klaves Shift, otdCanie bude obmedzené na nasobky
uhla 15 °.

Ide o predvolené spravanie klavesu Shift. Ak vSak je zaSkrtnuté volba Pri vytvarani
alebo presune objektov v Nastroje > Moznosti > LibreOffice Draw > MrieZka, je
funkcia klavesu Shift opa¢na: ota€anie bude obmedzené na nasobky 15 °, ked
klaves Shift nebude stlaCeny.

Poznamka

Skosenie objektu

Ak chceme skosit’ objekt, pouzijeme Uchytku v strede hornej, dolnej alebo bo€nej strany vybratého
objektu. Kurzor mySi zmeni tvar, ak ho presunieme nad niektoru z tychto Gchytiek. Os, podla ktorej
sa objekt skosi, je strana objektu, ktora sa nachadza priamo oproti pouzitej stredovej Uchytke. Tato
0s nemeni svoju polohu, zatial ¢o ostatné strany objektu sa presivaju podla toho, ako tahame
kurzorom mysi.

Klikneme a podrzime tlacidlo mysi, potom zaneme presuvat kurzor, ¢im objekt deformujeme.
Zobrazi sa priehladny obrys upravovaného objektu (obrazok 33) a v stavovom riadku sa zobrazi
aktualny uhol skosenia.

Ak pri koseni objektu stlatime klaves Shift, kosenie bude obmedzené na nasobky
uhla 15 °. Ide o predvolené spravanie Shift. Ak vSak je zaSkrtnuta volba Pri

Poznamka vytvarani alebo presune objektov v Nastroje > Moznosti > LibreOffice Draw >
Mriezka, je funkcia klavesu Shift opacna: kosenie bude obmedzené na nasobky 15
°, ked klaves Shift nebude stlaceny.
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Obréazok 33: Skosenie objektu

Uprava objektov

Ak chceme upravit objekt alebo zmenit jeho vlastnosti ako farbu, Sirku, ordAmovanie a podobne,
moéZeme pouzit panely nastrojov Ciara a vyplii a Forméatovanie textu, pole Vlastnosti na
postrannom paneli alebo kontextovl ponuku. Viac informacii o Gprave objektov a zmene ich
vlastnosti sa nachadza v kapitole 4, Zmena atribatov objektov prirucky Navod na pouzivanie
programu Draw (Draw Guide).

Ciara v vyplii *
[ @ ) S | V||U,U[Jcrn ¢||-Tangov| a |Farba VI V| = | & - %'ﬂ'

@ Styly a formatovanie % Stjl oblasti / wypli

@ Ciara Ll Ten

| Sty sipky 4] Obrazkova mapa

| Syl dEary @ Efekty

@ Sirka Giary @ Prevratit’

| Umiestnenie a velkost’
@ Farba Gary [E Zarovnanie
& Ohlast’ % Usporiadat’

Obrézok 34: Panel néstrojov Ciara a vyplii a jeho dostupné nastroje

Panel nastrojov Ciara a vypli

V predvolenom nastaveni sa panel nastrojov Ciara a vypli nachadza v hornej ¢asti pracovnej
plochy. Ak vSak zobrazeny nie je, zvolime Zobrazit > Panely nastrojov > Ciara a vyplii v hlavnej
ponuke, ¢im ho zobrazime (obrazok 34 ). Pomocou tohto panelu méZeme upravit' najCastejSie
pouzivané vlastnosti objektu. Aby sme ziskali pristup k dal§im moznostiam formatovania, mézeme

tieZ otvorit' dialégové okno Ciara tak, Ze klikneme na ikonu Ciara & , alebo dialébgové okno

Oblast tak, ze klikneme na ikonu Oblast’ &
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Panel nastrojov Formatovanie textu

Kedykolvek vyberieme text, panel nastrojov Ciara a vyplfi sa automaticky zmeni na panel
nastrojov Formatovanie textu (obrazok 35). Panel nastrojov Formatovanie textu mbézeme tiez
otvorit pomocou Zobrazit' > Panely nastrojov > Formatovanie textu v hlavnej ponuke. Nastroje
v tomto paneli nebudud aktivne, kym nebude vybrany text.

Formatovanie textu v X
Liberation Sans v||18 V| B J um |§|§ == |$|i. 3; |§|§ = ::mn; |§ “ﬂ E‘@ é-%
ﬁ Mazov pisma 2= Zmendit' medzerovanie
m Velkost' pisma = /| Riadkovanie: 1
B| Tuine =/| Riadkovanie: 1,5
7| Kurziva = /| Riadkovanie: 2
U | podfarknuts 5= | Odrazky zapjvyp
}'h Tien Zvadsit' pismo
& zZmensit' pismo

Zarovnat vlavo

£
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Na stred smer textu zlava doprava
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=
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Zarovnat’ vpravo Smer textu zhora nadol

Do bloku

El Znak
Sl ztava-doprava Bl Odsek
i. Sprava-dolava ,

& Farba pisma
$§ ZvadEit medzerovanie % Spedélny znak

Obrazok 35: Panel nastrojov Formatovanie textu a jeho dostupné nastroje
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Obréazok 36: Polia v podpaneli Vlastnosti na postrannom
paneli

Podpanel Vlastnosti ha postrannom paneli

Ked vyberieme objekt kresby, aktivuju sa polia v podpaneli Vlastnosti na postrannom paneli
(obrazok 36). Vdaka tomu mdézeme zmenit' vlastnosti alebo moznosti objektu bez nutnosti otvarat
dialégové okno alebo pouZzivat niektory nastroj z mnohych panelov programu Draw. Ak chceme
nejaku Cast rozbalit, klikneme na znamienko plus (+), ktoré sa nachadza vedla ndzvu Casti.
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Kontextova ponuka

Ak je vybrany objekt a klikneme nan pravym tlacidlom mysSi, otvori sa kontextova ponuka (menu)
(obrazok 37) prislusna k vybranému objektu. Pomocou tejto ponuky mézeme pristupovat

k viacerym polozkam, a tak mdzZzeme menit vlastnosti objektu bez potreby otvarat dialégové okno.
Polozky ponuky s malou Sipkou na pravej strane obsahuju podponuku.

{fy Ciara...

& Oblast...
Text...
B Umiestnenie a vetkost...

FA Znak...
Ell  Odsek...

|Isporiadat’ r

Zarovnanie J

Preniest’ dopredu

Preniest’ blizgie
P atit" .
crevre ' Preniest’ d'alej
Previest’ v
Preniest’ dozadu
Popis. ..

MNazov... Pred objekt

dd BT D

Za objekt

Upravit stil. ..

% Vystrihnat

=5 Kopirovat’
By viost
Obréazok 37: UkaZka miestnej ponuky

Formatovanie Ciar a oramovania

V programe LibreOffice m6ze pojem Ciara znamenat samostatnu Cast’ kresby (Ciara), vonkajSiu
stranu Utvaru (oramovanie) alebo Sipku. Vlastnosti Ciar, ktoré je potrebné menit najcastejSie, su
Styl (pIna, Ciarkovand, neviditeln& a podobne), hribka a farba.

Vyberieme Ciaru, ktord chceme formatovat, a potom pouzijeme ovladacie prvky na paneli nastrojov
Ciara a vypli, pomocou ktorych tieto ¢asto upravované vlastnosti zmenime (zvyraznené na
obrazku 38).

Giara a vyplii v %
@ ﬁ pars '[ w | |0,00mm % | | Tango V]@I Farba v = & - =§= M ﬂ'

Obréazok 38: Casto pouZivané vlastnosti Giary (Styl, farba, hribka)

Ak potrebujeme upravit vzhlad Ciary este inak, zvolime Format > Ciara v hlavnej ponuke,
klikneme pra\ém tlacidlom mysi na Ciaru a zvolime Ciara v kontextovej ponuke alebo klikneme na

ikonu Ciara na paneli nastrojov Ciara a vyplii. Pomocou vietkych tychto spdsobov sa otvori
dialégové okno Ciara (obrazok 15 na strane 17), v ktorom mdZeme nastavit vlastnosti &iary. Toto
dialogové okno sa sklada z troch zaloziek: Ciara, Styly Ciar a Styly Sipok. Alternativne mézeme na
zmenu vzhladu &iary pouZit pole Ciara v podpaneli Vlastnosti na postrannom paneli.
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Sipky, hroty Sipok a zakoné&enie &iar

Sipky, hroty ipok a daldie zakon&enia €iar sa spravidla oznacuju ako 3ipky. Ich vlastnosti méZeme
upravovat' a menit rovhakym spdsobom ako v pripade Ciar. Vyberieme Ciaru a klikneme na ikonu

< — . <
Styl Sipky —< na paneli nastrojov Ciara a vypli, ¢im otvorime ponuku Styl Sipky (obrazok 39).

Syl sipky ¥

—_—
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b

Obrézok 39: Ponuka Styl Sipky

K dispozicii je niekolko druhov Sipok. Kazda Ciara moZe konCit inou Sipkou alebo moZze zostat bez
Sipky. Sipky mozno pouZit iba v pripade Ciar, na ordmovanie objektu ich nastavenie nema vplyv.
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Formatovanie vyplne oblasti

Pojem vyplni oblasti oznacuje vnuatro objektu. Vyplii m6ze byt tvorena jednoliatou farbou,
prechodom, Srafovanim alebo rastrovym obrazkom (obrazok 40). Vypln je mozné nastavit’ ako
CiastoCne alebo Uplne priehlfadnu. Vo vacsine pripadov zvolime niektort zo Standardnych vyplni,
ktoré su dostupné na paneli nastrojov Ciara a vyplii alebo v poli Oblast vo Vlastnostiach na
postrannom paneli. M6Zeme tiez definovat vlastné vyplne oblasti. Viac informécii o formatovani
vyplne oblasti sa nhachadza v kapitole 4, Zmena atributov objektov, prirucky Navod na pouzivanie
programu Draw (Draw Guide).

Farba

Prechod

Srafovanie

Rastrovy
obrazok

Obréazok 40: Rézne druhy vyplne oblasti

Pouzivanie Stylov

MéZe sa stat, Ze chceme pouzit rovnaku vypli oblasti, hrabku Ciary alebo oramovania na sadu
objektov. Opakované nastavovanie vlastnosti mozno vyrazne zjednodusit' tym, Ze pouZijeme Styly.
Pomocou Stylov mdéZzeme definovat Sablonu s formatovanim (Styl) a potom tento Styl pouzit’ na
viacero objektov. Viac informacii o Styloch sa nachadza v kapitole 3, PouZivame Styly a Sablony
tejto prirucky, v kapitole 6 Uvod do $tylov priruéky Navod na pouZivanie programu Writer (Writer
Guide) a v kapitole 4, Zmena atributov objektov priru¢ky Draw Guide.

Umiesthiovanie objektov

Funkcia Zachytavanie

V programe Draw mdZu byt objekty presne a konzistentne umiestiiované pomocou funkcie
Zachytavanie. Na zachytavanie moézu byt pouzité body mriezky, zachytné body a Ciary, ramce
objektov, body na objektoch alebo okraje stranky.

Najjednoduchsie sa so zachytavanim pracuje pri priblizeni, ktoré je pre zobrazenie na pouzivanom
displeji praktické. Naraz je mozné pouzit dve r6zne funkcie zachytavania: napriklad zachytavanie
k zachytnym Ciaram a k okrajom stranky. Je vSak vhodné aktivovat' iba funkcie, ktoré su naozaj
potrebné.
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Viac informacii sa o funkcii Zachytavanie nachadza v kapitolach 3, Praca s objektmi a bodmi
objektov a 10, Pokrocilé techniky na kreslenie prirucky Draw Guide.

Zachytavanie na mriezku

Zachytavanie na mriezku umoZziuje umiestnit objekt na bod mriezky (obrazok 41). Zvolime
Zobrazit' > Mriezka > Zachytit' na mriezku v hlavnej ponuke alebo klikneme na ikonu Zachytit’
ﬁ

na mriezku ::::iii na paneli nastrojov MoZnosti, ¢im zachytavanie k mriezke zapneme. Pokial nie je
panel nastrojov Moznosti zobrazeny, zvolime Zobrazit' > Panely nastrojov> MoZnosti v hlavnej
ponuke.

Obrézok 41: Umiestriovanie s vyuZitim zachytenia na
mrieZku

Zobrazenie mriezky
Ak chceme v programe Draw mriezku zobrazit' alebo skryt, zvolime Zobrazit' > Mriezka >

Zobrazit' mriezku v hlavnej ponuke alebo klikneme na ikonu Zobrazit mriezku :::::::
nastrojov Moznosti.

Nastavenie mrieZky

RozliSenie a vlastnosti zachytavania k jej bodom mozno nastavit. Zvolime Nastroje > MoZnosti >
LibreOffice Draw > Mriezka v hlavnej ponuke, ¢im otvorime dialdgové okno s nastaveniami pre
mriezku (obrazok 42).
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MoZnosti - LibreOffice Draw - MrieZka

LibreCffice Mrieska
Nadtat/Ulosit’ Mez
Mastavenie jazyvka [ ] Zachytit na mriegku
= L'”‘ﬁ;‘lﬁgg“ [] viditelna mrieska
Zobrazit’ . B
Rozligenie Rozdelenie
Libr;l]affice Fase Vodorovné:  |1,00cm % Vodorovné: |10 ¥ | medzeraly)
frf?e?net Fvislé: 1,00cm % Zvislé: 10 + | medzeraly)
[] synchronizovat osi
Pozicia zachytavania
[1 Pri wytvérani alebo prestvani objektow
Rozsirit hrany
[ ] Ma orémovanie objektu L —
[] Pri rotadii 15,00°
[ ] Ma body objektu
. o s
Rozsah zachytdvania |Sbody Rechilrs badms | 15,00 S5
[ K ] [ Frusit’ ] [ Pomocnik ] [ Wratit’

Obrazok 42: Nastavenie mrieZKy

* V okne nastavujeme zvislé a vodorovné rozostupy bodov mriezky. Mé6Zeme tieZ zmenit
mernu jednotku nastavenu vo vSeobecnych moznostiach programu Draw tym, Ze zvolime
Nastroje > Moznosti > LibreOffice Draw > VSeobecné.

* Rozlidenie je velkost Stvorcov alebo obdiznikov mriezky. Ak je rozliSenie vodorovne 1 cm a
zvisle 2 cm, mriezka sa sklada z obdlznikov 2 cm vysokych a 1 cm Sirokych.

* Rozdelenie je predstavovane doplnkovymi bodmi, ktoré sa zobrazuju na stranach kazdého
obdlZnika alebo Stvorca mriezky. Objekt mozZno prichytit' k podruznym bodom rovnako ako
k vrcholom mriezky.

* Rozsah zachytavania v bodoch udava, do akej vzdialenosti od bodu alebo &iary je nutné
objekt priblizit, aby sa zachytil.

* Predvolenou farbou mriezky je svetlosiva. Ak chceme zmenit farbu bodov mriezky, zvolime
Nastroje > MoZnosti > LibreOffice > Vzhl'ad v hlavnej ponuke.

Vodiace Ciary

Vodiace cCiary programu Draw umoziuju lahko umiestnit’ objekt s vyuzitim pravitok na hornej a
l[avej strane pracovnej plochy. Ak chceme vodiace Ciary zapnut alebo vypnat, zvolime Nastroje >
MoZnosti > LibreOffice Draw > Zobrazit' v hlavnej ponuke a zvolime mozZnost Vodiace €iary pri
presuvani alebo zvolime panel nastrojov Moznosti a klikneme na ikonu Vodiace €iary pri

presivani i,

Pouzivanie Specialnych efektov

V programe Draw mdZeme pouZit' na objekty alebo ich skupiny vela Specialnych efektov. Tato ¢ast
predstavuje niektoré z nich. Viac informécii o Specialnych efektoch sa nachadza v kapitole 4,
Zmena atributov objektov, priru¢ky Navod na pouzivanie programu Draw (Draw Guide).
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Ak chceme pouZzit nastroje na Specialne efekty, zvolime Zobrazit' > Panely nastrojov > Rezim
(obrazok 43). Funkcie Otocit’ a Prevratit’ s dostupné aj v polozke Objekt v hlavnej ponuke alebo
ked klikneme pravym tlacidlom mySi na objekt a pouZijeme kontextovu ponuku.

ReZim *
ey

Otodt

Prevratt’

W 30 rotafnom objekte

Urniestnit' na kruznici (perspektvne)

Urniestnit' na kruznic (skosit)
Deformovat’

Priehladnost’

Prechod

Obréazok 43: Panel nastrojov ReZim a jeho dostupné nastroje

&0 E € e

Prevracanie objektov

NajrychlejSi a najlahSi spésob, ako objekt vodorovne alebo zvisle prevratit, je nasledujici postup:
1) Klikneme na graficky objekt, ¢im sa zobrazia Gchytky vyberu.

2) Klikneme pravym tlacidlom mysSi a zvolime Prevratit’' > Zvisle alebo Vodorovne alebo
zvolime Objekt > Prevratit’ > Zvisle alebo Vodorovne v hlavnej ponuke. Vybrany objekt
sa prevrati, bude teda orientovany opacnym smerom.

Mdzeme vSak pouzit' aj nastroj Prevratit' na paneli nastrojov Rezim alebo Kresba, ktory poskytuje
viac moznosti, ako prevracanie ovplyvnit. Ak pouzijeme nastroj Prevratit, mézeme zmenit
umiestnenie a uhol osi prevratenia, ako je opisané v kapitole 4, Zmena atributov objektov prirucky
Draw Guide.

Zrkadlové kopie

V st€asnosti nie je v programe Draw k dispozicii prikaz na zrkadlenie. Zrkadlenie objektu ale mdze
byt dosiahnuté pomocou nastroja Prevratit', ako je opisané v kapitole 4, Zmena atribltov objektov
prirucky Draw Guide.

Deformovanie objektov

Na paneli nastrojov Rezim su k dispozicii tri nastroje, ktoré umoznuja presunut vrcholy alebo hrany
objektu a tym objekt zdeformovat.

* Nastroj Deformovat’ ﬁ zdeformuje objekt z hladiska perspektivy.

* Umiestnit’ na kruZnici (skosit) % vytvori pseudotrojrozmerny efekt.

* Umiestnit’ na kruznici (perspektivne) QB vytvori pseudotrojrozmerny efekt.

Vo vSetkych troch pripadoch sa najprv zobrazi otazka, €i chceme objekt previest na krivku. To je
nevyhnutné, preto klikneme na Ano. Potom mézeme preslvat Uchytky objektu tak, aby sme
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dosiahli poZzadovany efekt. Viac informacii o deformovani objektov sa nachadza v kapitole 4,
Zmena atributov objektov priru¢ky Draw Guide.

Dynamické prechody priehladnosti

Prechody priehlfadnosti m6Zu byt nastavené rovnakym spdsobom ako prechody farieb. Oba typy
prechodov moZno pouZit spolu. V priehladnom prechode sa v jeho smere meni miera
transparentnosti farby vyplne objektu, a to od nepriehladné po priehladnu. V oby€ajnom prechode
sa meni vypli z jednej farby na ind, ale miera priehladnosti zostava rovnaka.

Na nastavenie prechodov priehladnosti a farby slizZia nastroje Priehladnost’ a Prechod na paneli
nastrojov Rezim. Viac informacii o vytvarani priehladnosti a prechodov farby sa nachadza
Vv kapitole 4, Zmena atribdtov objektov priru¢ky Draw Guide.

Duplikovanie

Pomocou duplikovania vytvorime képie objektu, pricom vlastnosti duplikatu, ako napriklad farba
alebo otocCenie, sa zarovefi mézu zmenit.

Duplikovat E|
—
Os X 0, 10cm E
OsY 0,10cm
Uhol 5o E Pomocrik
Fvacsenie
Sirka 0,00cm &
Viska 0,00cm ¥
Farby
Spustit’ I Cervend w
Koniec I Modrd Moja 01 w

Obréazok 44: Dialégové okno Duplikovat’

1) Klikneme na objekt alebo skupinu a zvolime Upravit’ > Duplikovat’ v hlavnej ponuke alebo
pouzijeme klavesovu skratku Shift+F3, €im otvorime dialégové okno Duplikovat’' (obrazok
44).

2) Z dostupnych moznosti zvolime poZzadovane. Ak su napriklad urcité nastavenia pouzité na
obdIZnik, vytvori sa vysledok zobrazeny na obrazku 45.
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Obrazok 45: Vysledok duplikovania

Prelinanie utvarov

Prelinanie utvarov postupne prevedie jeden objekt na iny. PouZit ho mozno iba vtedy, ked su
vybrané dva objekty.

1)
2)

3)
4)
5)

6)

Vyberieme dva objekty s odliSnym tvarom.

Zvolime Upravit’ > Prelinanie utvarov v hlavnej ponuke, ¢im otvorime dialégové okno
Prelinanie Utvarov (obrazok 46).

Zadame hodnotu Pocet krokov, ktora ur€uje poc€et doplnenych utvarov medzi dvomi
vybranymi objektmi.

ZaSkrtneme Prelinanie atributov, ak chceme postupne menit vlastnosti Ciary a vyplne
medzi oboma objektmi.

ZaSkrtneme Rovnaka orientacia, ak chceme dosiahnut’ hladky prechod medzi oboma
objektmi.

Klikneme na OK. Vysledkom je nové zoskupenie objektov, v ktorom je prvy vybrany objekt
na zacCiatku a druhy vybrany objekt na konci. Ak napriklad pouZijeme moznosti zadané

v dialogovom okne na kruh a na bublinu so Stvorsmerovou Sipkou, nastroj Prelinanie
Utvarov vytvori vysledok zobrazeny na obrazku 47.

Prelinanie utvarov

Nastavenia

4

Pocet krokov |16

Prelinanie atribitoy
Rovnaka orientada

| o« || zusr || eomomk

Obrazok 46: Dialégové okno Prelinanie atvarov
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Skladanie viacerych objektov

Pomocou programu Draw mézeme objekty zoskupit, vdaka €¢omu potom s viacerymi objektmi
zaobchadzame ako s jednym, alebo zlozit, ¢im vytvorime novy Utvar. Viac informacii sa nachadza
v kapitole 5, Kombinovanie viacerych objektov priru¢ky Navod na pouZzivanie programu Draw
(Draw Guide).

Zoskupenie objektov si mozno predstavit' ako vloZenie objektov do kontajnera. Objekty mdéZzeme
ako skupinu presuvat a naraz mdézeme menit atriblty vSetkych objektov v zoskupeni. Zoskupenie
vzdy mozno zruSit' a s objektmi, ktoré ho tvorili, je mozné opat zaobchadzat oddelene. Objekty

v zoskupeni si tieZ zachovavaju svoje vlastnosti.

ZloZenie objektov znamena ich trvalé zlGcenie, pri ktorom sa vytvori novy objekt. P6vodné objekty
nie su dalej dostupné ako jednotlivé prvky a nemdZzu byt ako jednotlivé objekty upravované.
Akakolvek Uprava zloZzeného objektu ovplyvni vSetky objekty, ktoré boli pri zloZeni pouzité.

Zoskupenie

Docasné zoskupenie

Docasné zoskupenie objektov dosiahneme tak, Ze pomocou ikony Vybrat % na paneli nastrojov
Kresba vyberieme niekolko objektov, alebo pomocou mysi pretiahneme okolo objektov obdiznik.
Akékolvek zmeny vlastnosti objektov, ktoré vykoname, sa pouZiju na vSetky objekty nachadzajlce
sa v doCasnej skupine. M6Zeme napriklad docasnu skupinu ako celok otocit.

Ak chceme doCasné zoskupenie objektov zrusit, jednoducho klikneme mimo objektov zoskupenia.

Trvalé zoskupenie

Trvalé zoskupenie objektov vytvorime tak, Ze objekty vyberieme a nasledne zvolime Objekt >
Zoskupit’' v hlavnej ponuke, klikneme pravym tlacidlom mysi na lubovolny vybrany objekt a
zvolime Zoskupit' v kontextovej ponuke alebo pouzijeme klavesovua skratku Ctrl+Shift+G. Aj ked
zruSime vyber, objekty zostavaju zoskupené.

Ak su objekty trvalo zoskupené, akakolvek operéacia pouzita na ich skupinu sa pouzije pre
vSetkych ¢lenov skupiny. Ak klikneme na niektorého ¢lena skupiny, vyberie sa cela skupina.

Jednotlivych €lenov skupiny méZeme upravovat bez toho, aby sme museli zoskupenie zrusit.
Vyberieme zoskupenie a zvolime Objekt > Vstupit’ do zoskupenia, klikneme pravym tlacidlom
mysSi a zvolime Vstupit' do zoskupenia v kontextovej ponuke, pouzijeme klavesovu skratku F3
alebo na zoskupenie dvojklikneme.
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AZ Upravy jednotlivych ¢lenov skupiny dokon¢ime, zvolime Objekt > Opustit’ zoskupenie,
klikneme pravym tlacidlom mysi a zvolime Opustit’ zoskupenie v kontextovej ponuke alebo
pouzijeme klavesovua skratku Shift+F3.

ZruSenie zoskupenia

Ak chceme zoskupenie objektov zrusit, vyberieme ho, a potom zvolime Objekt > Zrusit’
zoskupenie v hlavnej ponuke, klikneme pravym tlacidlom mysi a zvolime ZruS$it’ zoskupenie
v kontextovej ponuke alebo pouZijeme klavesovu skratku Ctrl+Alt+Shift+G.

Zlozenie objektov

ZloZenie objektov znamena ich trvalé zlicenie, pri ktorom sa vytvori novy objekt. Pvodné objekty
nie su dalej dostupné ako jednotlivé prvky a nemdZzu byt ako jednotlivé objekty upravované.
Akakolvek Uprava zloZeného objektu ovplyvni vSetky objekty, ktoré boli pri zloZeni pouzité.

Vyberieme niekolko objektov, potom zvolime Objekt > Zlozit' v hlavnej ponuke, klikneme pravym
tlacidlom mysSi na objekty a zvolime Zlozit' v kontextovej ponuke alebo pouzijeme klavesovu
skratku Ctrl+Shift+K.

Potom, ako vyberieme objekty, sa v podponuke Utvary v kontextovej ponuke spristupnia funkcie
Zlugit', Odcitat’ a Prienik, pomocou ktorych mézeme vytvorit' z vybranych objektov novy objekt.
Viac informacii o tychto funkciach sa nachadza v kapitole 5, Kombinovanie viacerych objektov
prirucky Navod na pouzivanie programu Draw (Draw Guide).

Usporiadanie, zarovnhanie a rozmiestnenie objektov

V programe Draw je mozné vybrané objekty usporiadat, zarovnat a rozmiestnit voci sebe
navzajom:

* Pod usporiadanim rozumieme presuvanie objektu v poradi objektov, a to bud blizSie, alebo
dalej, ¢im sa meni jeho viditelnost’ vzhladom na ostatné objekty.

* Objekty zarovname voci sebe vodorovne pomocou prikazov VIavo, Na stred alebo
Vpravo a zvisle pomocou Hore, Na stred alebo Dole.

*  Objekty mézeme rozmiestnit' tak, ze rozostup medzi nimi bude rovnaky.

Viac informacii o usporiadavani a zarovnavani objektov voci sebe sa nachadza v kapitole 5,
Kombinovanie viacerych objektov priru¢ky Navod na pouzivanie programu Draw (Draw Guide).

Vkladanie a uprava obrazkov

Program Draw obsahuje vela funkcii na Gpravu rastrovych obrazkov (bitmap), ako napriklad
fotografii alebo naskenovanych obrazkov. Medzi ne patri importovanie alebo exportovanie
obrazkov a konverzia z jedného formatu obrazkov na iny.

Program Draw podporuje viacero formatov obrazkovych suborov, a to pri nacitani, ako aj pri
ukladani. Zahfna tiez niektoré nastroje na pracu s rastrovou grafikou, avSak nedosahuje taky
rozsah funkcii, aky maju Specializované grafické programy ako Gimp alebo Adobe Photoshop. Viac
informacii sa nachadza v kapitole 6, Uprava obrazkov priru¢ky Navod na pouZivanie programu
Draw (Draw Guide).

Obrazky mdzeme pridavat z niekolkych zdrojov:
* Priamo zo skenera (VloZit' > Obrazok > Skenovat’)

* Zo suboru: obrazky vytvorené inym programom, a to vratane fotografii z digitdlneho
fotoaparatu (VloZit' > Obrazok > Zo suboru)
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e Z galérie programu Draw; viac informacii sa nachadza v tejto prirucke v kapitole 11,
Grafika, galéria a ozdobné pismo.

Praca s 3D objektmi

Hoci program Draw neobsahuje tolko funkcii ako Spickové programy na Upravu obrazkov, je v iom
mozné vytvarat’ a upravovat 3D kresby.

Program Draw ponuka dva druhy 3D objektov: 3D telesa a 3D utvary. Podla toho, aky druh
zvolime, mb6zeme vyuZit rdzne spbsoby Uprav 3D objektu (otoCenie, osvetlenie, perspektiva a
podobne), priCom 3D utvary mozno vytvorit' a upravit jednoduchSie ako 3D telesa. Na druhej
strane, 3D telesa je mozné v sucasnosti lepSie prispbsobit.

Viac informacii sa nachadza v kapitole 7, Praca s 3D objektmi priru¢ky Navod na pouzivanie
programu Draw (Draw Guide).

Exportovanie obrazkov

Program Draw uklada obrazky v otvorenom formate *.odg. Ak chceme uloZit obrazok alebo cely
subor v inom forméte, pouZijeme Subor > Exportovat’ a zvolime format zo zobrazeného
zoznamu. Zoznam formatov obrazkov, ktoré mdézu byt z programu Draw exportované, je uvedeny
v tejto prirucke v prilohe B Otvoreny softvér, otvorené Standardy, OpenDocument.

Subory programu Draw tiez m6zZeme exportovat do formatov HTML, XHTML, PDF alebo Flash.
Exportovanie do PDF z jednotlivych sucasti balika LibreOffice je opisané v tejto prirucke v kapitole
10, Tlac, exportovanie a odosielanie.

Pri exportovani do HTML sa na konverziu vyuzZiva sprievodca, ktory vytvori tolko webovych
stranok, kolko stranok sa nachadza v dokumente programu Draw . Volitelne mézeme zvolit, aby
sa stranky zobrazovali v ramcoch s navigaciou, a mézeme nastavit' vodnu stranku. Viac
informécii sa nachadza v tejto prirucke v kapitole 12, Vytvaranie webovych stranok.

Vkladanie komentarov ku kresbam

Ku kresbam mézZzeme vkladat komentare podobnym spésobom ako v programoch Writer a Calc.

1) Zvolime VloZit' > Poznamka v hlavnej ponuke. V favom hornom rohu kresby sa zobrazi
obdIznik s inicidlkami autora a vedla neho vacsie textové pole (obradzok 48). Do dolnej Casti
textového pola program Draw automaticky vloZi meno autora a datum.

2) Do textového pola napiSeme alebo vloZime text. Na Casti textu méZeme pouzit' zékladné
forméatovanie tak, Ze Cast' vyberieme, klikneme na fu pravym tlacidlom mysi a zvolime
moZnost v kontextovej ponuke. Z tejto ponuky tiez mézeme zmazat aktualny komentar,
v3etky komentare od toho istého autora alebo v3etky komentare v dokumente.

3) Obdiznik oznagujici komentar mdZeme presunit na akékolvek miesto kresby. Obvykle ho
presuvame na miesto blizko objektu, s ktorym suvisi.

4) Ak chceme komentéare zobrazit alebo skryt, zvolime Zobrazit' > Poznamky v hlavnej
ponuke.
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Obréazok 48: Vkladanie poznamok

5) Ak chceme zadat meno, ktoré sa v komentari zobrazi ako meno autora, zvolime Nastroje

> MoZnosti > LibreOffice > Udaje o pouzivatel'ovi.

6) Ak dokument upravuje viac ako jedna osoba, kazdému autorovi je automaticky priradena

ina farba pozadia poznamky.
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